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This process moves employees who receive their first paycheck in July from next year Position
Management to current year Position Management. It also updates some of the fields on the
following Maintenance tabs in the current year (see step 7 for detailed information):

Employment Info
Pay Info

Job Info
Distributions

A separate simulation needs to be set up for employees who receive their first paycheck in July.
This is necessary because the position in the next year Position Management reflects the current
year’s salary information. The simulation updates the fields in the next year positions for the new
school year and clears the Accept Changes field. The new salary information from the next year
position is updated in the current year, updating both the current year Position Management and
the Staff Job/Pay Data fields for those employees. As 12-month employees do not accrue, it is not
necessary to move them to the next year payroll. Contact your regional ESC consultant to discuss
moving 12-month employees to the next year payroll.

Note: Depending on the LEA, it may not be necessary to set up separate simulations. If the LEA
has determined next year salaries and completed all interfacing to Budget for the year, one
simulation can be used when moving employees. Contact your regional ESC consultant to discuss
this option.

It is important to consider how this process affects the budget. If you update 12-month positions
with the new salary amount for the next school year in the next year Position Management,
running the simulation a second time at a later date for all employees gives the 12-month
employees an additional increase. If you were unable to update the budget with accurate salaries
for all employees prior to rolling 12-month employees, it is necessary to update Budget with
multiple simulations. Reference the Interface to Budget Checklist.

The following checklist assumes the LEA has interfaced the payroll salaries to Budget using the
Salary Simulation process in Position Management.

TIP: Be sure to complete service records and extract June TRS before continuing this
process. This process updates the begin and end contract dates for 12-month employees
in the current year payroll. Service records must reflect the begin and end dates from
the current school year, and these dates are used to calculate the days and hours
worked for TRS purposes. This process will overwrite the employee’s calendar with the
calendar for the new year. If June TRS has not been extracted, the system is unable to
calculate this information for June.

1. Verify account code fiscal years.

Position Management > Utilities > Update Fiscal Year by Fund

Verify that the account code fiscal years are accurate. This tab provides a list of the fund/fiscal
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years that are set up in the positions. This process increments the position distribution fiscal
year by 1.

Note: Since the account codes are validated against the budget, there should not be any
fiscal years less than the next year. If there are, generate a user-created report to identify
the positions and manually update the information.

2. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last
year.

O It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:
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[ Save ] [ Create Report ] [ Delete ] [ Reset ] Year; C e

PMIS Pasition/Distribution Export File Auto Select Options

D PMIS Pogition Control D PMIS Position Distribution

DPMIS Pasition Control

[ JCYRMYR Flag [ contract Beg Date [Jpay Empld Pet [JExtra Duty Code

it [ Contract End Date Pt of Year (Jsupelement Type [(Joce Fay Type
D Payoff Date DPE‘- Concept D Supplement Max Amt D Suppl Recaloulate
[ nbr Days Cif : [ Base Suppl On Diy Rate Oray step [(Jtgn Pet Day For Sal Calrs
DA:! Hrly Dly Rate D Supplement Pay 1 Time [jp;,r Schedule D Ign Pet ¥r For Sal Cales

Units [ Mew Employee

[Jpate Supplement 1 Time [JFTE-

[:]I"u_r_ on School Year I Mbr Remain Payments I DMaA Days Gﬁ::est Change D‘Jicpo nt Base
E]Fr:—:,ency |_Jlob Categary DMm Payments D Date Create/Update DPe'cmt of Midpaint
DG.:: Employee Mbr D Supplement Attached DU-.-'.'.’ Elig Fig B Date Fill Dune/‘"plc-,-me'.t Elig Flag
[ ]Primary Job ek Code [J5tate Minimum Days [JFill Pesition Reasen [JFica Elig

I’.:'ease Elig D 1st Pay Date Code DS::ws: Position Mbr G Date Criteria D._-_lS Status Code

|J O Pay Grade D Calendar Cade DSms: Billet Mbr D Drate Authorization DBch_: et Amount
D"Jc: Fay Step D Campus I DSupo.eme nt Extra Days D Date Authorization End DBng et Salary Override
[JOec Fay Schedule e [J5upet to Pos Mer [Joate Entry [O#cwaliBudget Ind
DSta:e Step D Hirs Per Day DSJPO. to Pos Billst D Diate Inactive DPEV Type

DPMIS Position Distribution

[JCYRMNYR Flag [Jiek Code [JFunction [JEd Span (Jexpense 273
Dl"csi: on Mbr D;‘\ccsu nt Type D Object D Project Detail DC.:.ﬁ'.‘iI:- At Flag
DE Llet Nbr Df‘a\r Activity D Sub Object D;"u‘.ccun: Ameount
Dr‘csizjn Type D'v‘.'c'ké's Comp D Organization D;*u'_:cun: Percent
[ vistribution Segquence OFte D [ Fiscal Year [ TRs Grant Code
DFreq_encT DFunc D Program Intent D Extra Duty Code

DEmplwae Demo

DMJclsNaﬂ‘-:- D-Ge'.era:ic'.

O Click Create Report. The report is displayed. Use the sort/filter functionality to group the
applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

3. Verify retiree information.

Position Management > Maintenance > PMIS Position Modify > Budget

Verify that the TRS Status field is set to 5 - Retired for retirees. If the TRS status is incorrect,
there is a possibility that the status will be incorrect (TRS-eligible) when the employee is moved
to the current year payroll.
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4. ldentify employees to be moved to current year payroll.

Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report to identify the employees who begin their new contract in July. It
is possible that the employees are inactive in the current year, be sure that the Active
Employees Only field is not selected.

[ Save ] [ Create Report ] [ Delete ] [ Reset ] Year: C Frequency: 6 E

Report Templats

[ JQrubic [ Rewiee | [ Directony

Report Title

( J

Employee \lnr{:]g [JActive Employees Only

D Employee Demographic

[(JseaffiDissn [(JMaiden Name O [JusstChangsDate  [JEmer Contact [Hispanic/Latine
| ] Texas Unigue Staff ID Oa Mumber [JFarmer Frefix Oen Oei ip [ Retationship [JAmerican Indian
[JMame Prefix Ostreet/P.0. Box [Jrormer First Name O Om [JEmer Nates O#sian

I Z First Mame I Da‘u:-t D Former Middle Name D D i D Emer Area Cd Da‘-.fr can American
[ JMiddle Name Ocity O Loc [JemerPhonemsr — [JR: ander

| [v]Last Name | [Ostate Ce [JEmer Ext White
[(JGeneration Ozie iic
Oszex DOazip+4 OoL state Home Email
DDUE Da‘-.cu' Country D DL Expir Date D Employee Notes

chb Information

[Oopaily Rate Oovertime Eligible [Owerkers' Comp Cd

5 Oty Rate [Oovertime Rate [Owerkers' Comp Annual
Orrimary Job = in Contract [OFay Rate OHoursay [Owarkers' Comp Remain
DI”ri"’ Campus DL’aleu‘dar Code D Local Contract Days DS:ate ) D Base Annual DTF!& Position Cd D Exempt Status
DL’amous Name DL’cu‘tra:'. Begin Dt D Nbr of Annual Pymts DC.:A'..'a:: Total D;‘\:c'ua. Cd D State Minimum Salary D Incr Pay Step
[OMbr Men Contr [Jcontract End Dt [ORemaining Pymts [Jcentact Balance [O#Accrual Rate [OTRs Year [JVacant Position
D\'rs of Job Exper GT': in Career Ladder D Whly Hrs Sched D'\-‘:hol.e Sep Amt D Reg Hrs Worked D Retiree Exception

[Opistribution

Diab cd [JExtra Duty Cd [Oworkers' Comp Oray Acty [Occt Amt Ocet Pet [JTRS GrantCd
DFu nd Dtlojec( DSU‘J Object DL’lrga’- zation DF scal Year DI”ro; ram Intent DEU Span

[Ocontrib Acct Flg

[JDeductions

[OJpeduction Cd [Oemployes Amt [JEmployer Amt [JRemain Pymts [ Rrefund [Jcafe 125 [JEmplr Contrib Factar [JTEA Cantrits Factar

O Prepare a list of new hires as a supplement to this list. Sort by the Payoff Date to verify that
all employees who have a June payoff date have the same date. For example, it is possible that
an employee has a payoff date that is a day before or after the actual June payoff date.

O Generate a user-created report again to verify that all of the data is accurate. Filter the report
using your LEA's June payoff date (YYYYMMDD).
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Sort/Filter

[ v [] Sort Criteria l

| - [z] Filter Criteria |

[ Add Critericn ] | Delete Selected

D Column Crperator Value Legical
O ) (eozz0es )
[ O ] [ Cancel

Print or save the report.

5. Create a salary simulation.

Log on to the next year.

Prior to setting up and performing salary simulations, review the Position Management:
Salary Simulations Overview guide for a description of the Salary Simulation pages and
samples of the available simulation reports.

Position Management > Utilities > Salary Simulation > Simulation Options
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Simulation Na E Simulation DEu'iptimi 12 MOMTH STAFF FOR PR ] H

SIMULATION OPTIONS FIRST PAY DATE CODES FUNDVFISCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATH

If updating tables,

jease create export for Budget Tables

Retrieve l l Add Simulation l [ Execute l [ Delate ] prior to using this utility.
Simulation Mame: Simulation Desaription: [‘_2 MONTH STAFF FOR PR ] User IDx
Calculation Options Update Options
Include Proposed Pesitions Update for Active Positions [5 - Move Actual Amount to Budget Amount v]
Only:

‘ Include Vacant Supplement Positions:

Increment Pay Steps.

Forecast
Budget: [‘J - Do mot update Budget v]
I

Update Budget Amount: [-‘l - Recommended Amouwnt V]

Round Budget Amaount to

nearest dollar:

Maximum Annual Pay Step:

Maximum Hourly/Daily Pay Step:

Increment State Steps:

Include TRS On-Behalf Caloulations:

Expenditure Account for TRS On-Behalf [.,.;ql;(_;q;.gmz WO ]
Calculations:

For Midpoint Salaries - Basis of Salary Change [': - Use position hrlyfdly rate v]
For Midpoint Salaries - Increase Pay Rate to No W

Mimirniunn:

Include TEA Health Insurance

O Complete the following:

o (Recommended) In the Include Vacant Supplement Positions field, select No.

o In the Update Forecast field, select No.

o In the Update Budget field, select N - Do Not Update Budget.

o Include all first pay date codes for 12-month employees who receive their first paycheck
in July. Include all local/annual, hourly/daily, midpoint (if applicable), and extra duty
tables.

o If increases are not provided to 12-month employees in July, do not include an increase in
the salary tables. If increases are provided to 12-month employees in July, update the
salary tables with the increase data.

o If the LEA decides to interface the simulation to Budget, add the deductions with the
annual amount for the Employer Contribution.

O Click Save.

O Click Execute. Review the Simulation Process Error Listing and correct any errors prior to
continuing the process.

o Generate the simulation reports and review all salaries.

o Review the user-created report to confirm that all 12-month employees or positions are
included in the simulation. The reflected salaries are the amounts that are used to pay
employees in the current year payroll.

If necessary, continue making corrections and running the simulation until all of the salary
amounts are correct.
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O Run the final simulation. This process updates the included state step, pay step, and salary
amount in the next year PMIS for all 12-month positions and clears the Accept Changes field.

o In the Update Forecast field, select Yes.

o Click Save.

o Generate and save the reports.

o Click Process to process the simulation. Create a backup.

6. Copy school calendars from next year to current year payroll.

Log on to the next year.

Payroll > Next Year > Copy Next Year Tables

COPY NEXT YEAR TABLES *

1 O [ ” Select All Tables
] O
| O
] O :
] O =

Accrual Calendar

Extra Duty Pay

Hourly / Daily Salary

lob Code

Local Annual Salary

Midpaint Salary

| O &
@cuc (copcrcse ]
J O 3

State Minimum Salary

‘Workers' Compensation Rates

|
Substitute Salary [ ] O s
[ ILHE

O In the School Calendar field, select only the 12-month employee calendars.

./ TIP: The calendar code is displayed in the first pay date code on the simulation
& (e.g., J40 includes calendar code 40).

O Click Execute.

Note: If changes were made to the next year payroll tables (extra duty pay, hourly/daily
salary, job code, local annual salary, etc.), copy the tables from the next year payroll to the
current year payroll.

7. Generate a user-created report.

2026/06/26 04:20 7 pmis_updatingnyrpositions_and_rollingl2moemployees


https://help.ascendertx.com/business/doku.php/general/pmis_backup
https://help.ascendertx.com/business/doku.php/payroll/nextyear/copynyrtablestocyr
https://help.ascendertx.com/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_copynyrtablestocyr.jpg?id=general%3Apmis_updatingnyrpositions_and_rolling12moemployees

Business

Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report with the Hrs Per Day field selected. This field is overwritten
when positions are moved from the next year to the current year.

8. Move forecast to current year position and payroll

Log on to the next year.
Position Management > Utilities > Move Forecast to CYR Position and Payroll

This process is used to move payroll and position forecast records to the current year PMIS with
the same information that is set up in the next year PMIS records.

It also updates fields on the following Maintenance tabs: Employment Info, Pay Info, Job Info,
Distribution

The Accept Changes field must be cleared when moving position records from forecast to
current; otherwise, position records cannot be moved. The Accept Changes field is cleared
after running a simulation with the Update Forecast field set to Yes. Similarly, you cannot run
a simulation for positions without the Accept Changes field selected.

s
5 - Semimonthly CYR v ’

Select Pay Freguency:

Inclide Vacant Supplements:

Walidste Accounts against General Ledger

Update TRS Year Flag:

Update Workers' Comp Annual and Remaining Payments:

BHHDE

Add Additional Workers' Comp Payments:

Select State Minimum Salary Table (CYRMMNYR]):

Select First Pay Date Codes or blank for ALL:

Include Extra Duty:

Select Extra Duty Codes or blank for ALL:

Select Positions or blank for ALL:

{Includes ALL billets for selected positions [ ] :]
Blank for ALL not processed when Positions/Billets selected)
Select Positions/Billets or blank for ALL: [ ] :

Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL not processed when Supplement=/Billets selected)
Select Supplement Positions/Billets or blank for ALL: [ ] [:]

Clear Job Years: D

Clear Job Weekly Hours Scheduled: D
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Select Pay Frequency

Click ¥ to select the pay frequency where you want to move
to the current year. This is a required field.

Include Vacant Supplements

Select to include the vacant supplement positions.

Recommendation: Do not select this field unless it is your
final move.

Validate Accounts against
General Ledger

This field is selected by default. Clear this field to not validate
the accounts against the general ledger.

Recommendation: Select this field if you are doing your first
test move. By doing so, the appropriate errors are generated
to inform you of incorrect account codes in PMIS. If not
selected, those account codes are moved to Payroll if each
account component is valid.

Update TRS Year Flag

Select to update the TRS Year field on the Payroll > Staff/Job
Pay Data > Job Info tab.

Recommendation: Select this field if the employees being
moved will receive a contract payment prior to the first pay
date of the new school year (i.e., July and August starts).

Update Workers' Comp
Annual and Remaining
Payments

Select to update the WC Ann Pymts and WC Remain fields
on the Payroll > Staff/Job Pay Data > Job Info tab.

The WC Ann Pymts field indicates the number of annual
workers' compensation payments for the contract period and
the WC Remain field indicates the number of remaining
workers' compensation payments to be made during the
contract period.

Add Additional Workers'
Comp Payments

Type the number of additional workers' compensation
payments. The field accepts any value between 0-9.

This field is helpful as it can be difficult to identify which
months have a third payroll for the biweekly frequency. You
can use this field to add one or two to the contract months
times two.

Select State Minimum Salary
Table (CYR/NYR)

Click ¥ to select the current year or next year. This is a
required field.

This selection determines which salary table is referenced
when calculating the state foundation salary.

Select First Pay Date Codes
or blank for ALL

Select the first pay date codes that begin their new contract
payout. Type the pay date codes, separating multiple pay
date codes with a comma but no space (e.g., 1,17,88,A1). Or,

click ¥ to search for pay date codes. Otherwise, leave blank
to use all pay date codes.

Include Extra Duty

Select to include extra duty in the process. If not selected, no
extra duty will be processed even if extra duty codes are
selected.
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Select Extra Duty Codes or
blank for ALL

Select all of the supplements as only those supplements that
are tied to an employee being moved based on the first pay
date code will be selected. You can select a supplement even
if it is tied to an employee who you do not want to pay yet.
Type the extra duty codes, separating multiple extra duty
codes with a comma but no space (e.g., 08,20,A2,TF). Or, click

! to search for extra duty codes. Otherwise, leave blank to
use all extra duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions Blank for
ALL not processed when
Positions/Billets selected)

Type the position codes, separating multiple position codes

with a comma but no space (e.g., PRIN,T187). Or, click ¥ to
search for position codes. Otherwise, leave blank to use all
position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple
position/billet codes with a comma but no space (e.g.,

PRIN/00001,PRIN/00006). Or, click  to search for
position/billet codes. Otherwise, leave blank to use all
position/billet codes.

Select Supplement Positions
or blank for ALL (Includes
ALL billets for selected
supplement positions Blank
for ALL not processed when
Supplements/Billets
selected)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,

PRIN,T187). Or, click ¥ to search for supplement position
codes. Otherwise, leave blank to use all supplement position
codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space

(e.g., PRIN/O0O001,PRIN/00006 ). Or, click ¥ to search for
supplement position/billet codes. Otherwise, leave blank to
use all supplement position/billet codes.

Clear Job Years

Select to reset the job years to the default value (blank) on
the employee's job record.

If not selected and the employee's forecast position job code
is the same as the current year job master record, then the
new job record is populated with the values from the current
year job master record.

Clear Job Weekly Hours
Scheduled

Select to reset the weekly hours scheduled to the default
value (blank) on the employee's job record.

If not selected and the employee's forecast position job code
is the same as the current year job master record, then the
new job record is populated with the values from the current
year job master record.

O Click Execute to execute the process. The following reports are available:
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Processing Reports

Report Mame
Mowe Forecast Process Ermor Listing
Update CYR Positions From Forecast

Update CYR Payroll From Forecast by Employee Name

oooo g

Update CYR Payroll From Forecast by Campus ID

| Genersterepons || seecar || Unseecrau

o Move Forecast Process Error Listing Important errors

Error Message Description

Warning: The employee has
Contract Balance amounts not |The employee has not been paid off by payroll.
equal to zero for current jobs.

Failure: Position Accept

Changes Flag set to Y The position will not be moved to the current/payroll.

Failure: Emp Nbr must have [The error does not necessarily reference the Primary
one position declared as Job field on the position. If an employee has a regular
primary. position and a supplement position, but there is an
error that causes the primary position to fail, this
message often indicates that there is only a
supplement position to be moved. It is recommended
to review and correct any errors that begin below this
message about primary positions. After making those
corrections, run the process again. This may resolve
the primary job errors.

This error also occurs when calendars have not been
copied to the current year.
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Error Message

Description

Warning: Emp Nbr has
multiple supplement positions
for the same job; however,
one or more of the following
do not match: Campus ID,
Dept, TRS Status Code, FTE
Units, Incr Elig, Max Paymts,
FICA Elig, Unemp Elig, EEOC,
Workers Comp, Supplement
Extra Days or Category Cd.
The values from lowest
Supplement Position
Number/Billet may be used if
new rows are inserted for the
Pay Info and Job Info tabs.

This error indicates that the fields on the Payroll >
Tables > Salaries > Extra Duty tab do not match
those selected on a supplemental position.

Use the Position Management > Inquiry > PMIS Staff
Inquiry to determine the Position Number and Billet
for any supplemental positions for the employee.
Then, use the Position Management > Maintenance >
PMIS Supplement Modify page to retrieve the position
and billet and compare the fields on the position to
the Payroll > Tables > Salary > Extra Duty tab for the
extra duty number on the supplement. For example,
in some cases the W/C code on the position may not
match the W/C code on the table. Or, the Exp 373
field on the position may be selected, but the Exp
373 on the table for that extra duty code may not be
selected. Either the table or the position needs to be
updated so that they both match. If changes are
made to the Extra Duty table, it is necessary to move
the table to the current year payroll before
proceeding.

Date Run: Move Forecast o CYR Position and Payroll Ermors
Cnity Dist: 15D Pagec 1 of 4
Paosition Mbe Billet Mbr  Pos Typ  Eror Message

Failure: Emp Mir 000007 must have one position declared as primany.
Failure: Emp Mir 000128 must have one position declared as primary.
Failure: Emp Mbr 000148 must have one position declered as primany.
Failure: Emp Mir 000200 has unprocessad Reg Hours, Ovem Hours, or Abs Ded transmittals.
Failure: Emp Mir 000200 must have one position declared as primany.

Eaibire Emn Mo (08 o=t bave one nosition declbred s nrimses

o Update CYR Positions From Forecast - The error report lists any funds that need to be set
up in the Finance tables.

Date Runc Update CYR Positions From Forecast
Cnity Dist: IS0 Page: 1 of 1
Position Mbr Billet Mbr  Pos Typ Description Employpes Mumber Employee Name
Mo Rows Mo Rows “acant
End of Report

o Update CYR Payroll From Forecast by Employee Name
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Date Run: Update MR Payroll From Forecast by Employee Mame
Cnity Dist: 15D Page: 1 of 1
Schoaol Year:
Emp Mbr Employes Hame
Field Oid = Field Oid MNew Field Oid Mew
No Riows Vacant Freq:
Employment D=t Campus Contract Amount
Pay S=ws Primary Job Contract Remain Amt
FICA Eligibl= Creertime Eligible Pay Rate
Unermg Eligible Incre=ss Eligible Hriy/Diy Rate
TRS Status Calendar Code Crzrtmz Rate
Job Code St Sep Dock Rate
Pay Concept TRS Year Saate Min Szlary
Fay Type TRS Position Code Mbr Mon Contr
Contract Begin Dste Accrzl Code Mbr Annl Pymis
Contract End Dzte Ex=mpt Status Mbr Rem Pymts
Fayoff Cate hbr Days Contract Job Pt Az=gnd
Fay Grads hbr Days Empld Pict D=y Empld
Fay S=o Mz Cay= Hrs Per Day
Sched Wik's Comp Annl Mbr Diays OF
EEOC Code ‘Wrk's Comp Remain

o Update CYR Payroll From Forecast by Campus ID

Wrk's Comp Remain

Date Run: Update NYR Payroll From Forecast by Campus ID
Cnty Dist: 15D Page: 1 of 1
School Year:
Emp Mbr Employes Name
Field Oid = Field Oid Mew Field Oid Mew
Mo Rows Vacant Freqr
Employment Dats Campus Confract Amount
Fay Sw=tus Primary Joo Consract Remain Amit
FICA Eligible Crezstirme Eligible Pay Rate
Unemg Eligible Incre igible Hriy/Déy Rate
TRS Status Calendsr Code Iwertmz Fate
Job Code SiEte Swep Dock Rats
Pay Concept TRS Year Sazte Min Sslary
Pay Type TRS Position Code Nbr Mon Contr
Coniract Begin Cate Accrual Code Nbr Annl Pymts
Contract End Date Exemipt Status Mbr Rem Pymts
Fayoff Cate Wbr Days Contract Job Pt A==gnd
Fay Grads Mbr Days Empld Pt Day Empld
Pay B=c Max Day= Hrs Per Day
Wrk's Comp Annl Mbr Days Off

U Click Generate Reports. The selected reports are displayed. Review the report.

O Click Continue to view the next report. Or, click Return to return to the report selection

page.

O After reviewing all of the reports and correcting all errors, return to the report selection
page and click Process to move the forecast records to the current year. You are prompted

to create a backup.

After the process is completed, the actual update is performed. If the update is
successful, a message is displayed indicating that the move forecast updates were

processed successfully.

Reminder: If fund/fiscal year(s) were added to Finance based on the error report listing,
they should be deleted at this point.
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O Click Cancel to return to the Move Forecast to CYR Position and Payroll page without
moving the forecast records to the current year.

If corrections are processed, repeat this step.

Generate and save each report. Compare the Update CYR Positions From Forecast report to
the user-created report that was previously generated to confirm that all 12-month
employees are included. The last two reports contain the same information; one is sorted by
employee name and the other by campus ID. These reports reflect the existing salary in the
current year payroll and the new salary, which overwrites the current year payroll amounts.
Review the reports for accuracy.

9. Confirm that CYR salaries are accurate.

Log on to the current year.

Verify the current year data to confirm that the salaries are correct. The following fields are

updated:
W Matenance » Empiayreect infa. » Personnel =
Frplowte |’_ |
= Ir-201 )
R i =] [____ [ ~ ]
Vet e Erplopest I__: [Frad-Ties ~
c e & :) iz (] I_%_‘;:
e [ - =
T =1 3|
T = C
3| 2 [m]
~) =0
‘m)
e = e [ ~) ] [ ] [
m ™ @ — | , .
= ez e ] g S O
e )1 O O O O O
- L | A F o Oog [
] @ B g EEEE
'@ @ @ G
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Employes: [ |

PAY INFO OB INFO DISTRIBUTIONS DEDUCTIONS LEAVE BALANCE

Delete Details  Job Code Extra Duty Account Type

Account Code Amount Percent
] o 1158 - TECHNOUOGY TECHNICIANS G 155-53-0125.00-535-259000 2530600 100.000%
Total 2830600 100.000%
Rows: 1of 1  Refrgsh Totals v}
soo fooe [ 1158 - TECHNOLOGY TECHMNICL W |
Extra Duty Code: [ w | Activity Code [£0 Base Salary w | l " .
Account Type: G Standard gross pay v] TRS Grant Code
Acoount Codw: (199-53-6129.00-395-299000 J Warker's Comp Code:  BE5S-PROFAIDES/ADMS.
geription
Daezcription; Expense 373 1‘. Account not used in ASE distr WV il
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10. Mass update fiscal year.

Log on to the current year.

Payroll > Utilities > Mass Update > Employee

Skip this step if your LEA has a 7/1 fiscal year.

Mass update the fiscal year to the current school year for all employees.

Select Fiscal Year and type the current year fiscal year. Before processing, stop to consider if
the LEA uses other fiscal years in the account codes for employees. If the entered year is not
the only used fiscal year, additional parameters may need to be selected.

Contact your regional ESC consultant if you need assistance.

Identify those employees with a June payoff date and mass update the Hrs Per Day field.

o For LEAs that use the hours per day functionality in the current year payroll, select the
Hrs Per Day field and type the number of hours per day for the majority of employees.
o Use the parameters to select specific groups of employees for the update.
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